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Warranty and Liability 
 

Note The Application Examples are not binding and do not claim to be complete 
regarding the circuits shown, equipping and any eventuality. The Application 
Examples do not represent customer-specific solutions. They are only intended 
to provide support for typical applications. You are responsible for ensuring that 
the described products are used correctly. These Application Examples do not 
relieve you of the responsibility to use safe practices in application, installation, 
operation and maintenance. When using these Application Examples, you 
recognize that we cannot be made liable for any damage/claims beyond the 
liability clause described. We reserve the right to make changes to these 
Application Examples at any time without prior notice.  
If there are any deviations between the recommendations provided in these 
Application Examples and other Siemens publications – e.g. Catalogs – the 
contents of the other documents have priority. 

We do not accept any liability for the information contained in this document. 
Any claims against us – based on whatever legal reason – resulting from the use of 
the examples, information, programs, engineering and performance data etc., 
described in this Application Example shall be excluded. Such an exclusion shall 
not apply in the case of mandatory liability, e.g. under the German Product Liability 
Act (“Produkthaftungsgesetz”), in case of intent, gross negligence, or injury of life, 
body or health, guarantee for the quality of a product, fraudulent concealment of a 
deficiency or breach of a condition which goes to the root of the contract 
(“wesentliche Vertragspflichten”). The damages for a breach of a substantial 
contractual obligation are, however, limited to the foreseeable damage, typical for 
the type of contract, except in the event of intent or gross negligence or injury to 
life, body or health. The above provisions do not imply a change of the burden of 
proof to your detriment. 
Any form of duplication or distribution of these Application Examples or excerpts 
hereof is prohibited without the expressed consent of the Siemens AG. 

Security 
informa-
tion 

Siemens provides products and solutions with industrial security functions that 
support the secure operation of plants, systems, machines and networks. 
In order to protect plants, systems, machines and networks against cyber 
threats, it is necessary to implement – and continuously maintain – a holistic, 
state-of-the-art industrial security concept. Siemens’ products and solutions only 
form one element of such a concept. 
Customer is responsible to prevent unauthorized access to its plants, systems, 
machines and networks. Systems, machines and components should only be 
connected to the enterprise network or the internet if and to the extent necessary 
and with appropriate security measures (e.g. use of firewalls and network 
segmentation) in place.  
Additionally, Siemens’ guidance on appropriate security measures should be 
taken into account. For more information about industrial security, please visit 
http://www.siemens.com/industrialsecurity. 

Siemens’ products and solutions undergo continuous development to make them 
more secure. Siemens strongly recommends to apply product updates as soon 
as available and to always use the latest product versions. Use of product 
versions that are no longer supported, and failure to apply latest updates may 
increase customer’s exposure to cyber threats. 
To stay informed about product updates, subscribe to the Siemens Industrial 
Security RSS Feed under http://www.siemens.com/industrialsecurity. 

http://www.siemens.com/industrialsecurity
http://www.siemens.com/industrialsecurity
http://www.siemens.com/industrialsecurity
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Preface 

Aim of the Application Example 

The aim of this application example is to provide you with a ready-made and 
unified example project for a wastewater treatment plant as a quick introduction 
and to support the development of APC knowledge (Advanced Process Control), 
based on the corresponding equipment modules. This example project can be 
used as a model for projects of your own and adapted to individual requirements. 

Key Content 

The following core contents are covered in this application example: 

 Structure and instrumentation of aeration tanks and secondary clarifiers of 
wastewater treatment plants with intermittent operation 

 Description of the individual functions and parameter assignment 

 Working with the application example 

Validity 

From PCS 7 V8.1 SP1 with IL (Industry Library) and CFC V8.1 SP1 Update 3 
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1 Task Description and Solution 

1.1 Task 

The standardization of automation engineering for urban water management 
plants, such as water treatment, is a major challenge. Different process steps and 
procedures, different equipment and flexibility in the plant configuration make the 
task even more difficult. 

The largely automated operation of wastewater treatment plants is considered 
state of the art. Compared to process plants in other industries, such as 
the chemical industry, a wastewater treatment plant has fewer sensors and control 
loops. Nevertheless, the automation of wastewater treatment plants has its own 
special challenges: 

 The wastewater treatment plant generally discharges directly into public 
flowing waters. The wastewater treatment plant operator is therefore liable for 
complying with legal limits in purified wastewater, such as limits for ammonium 
nitrogen NH4-N, total nitrogen, chemical oxygen demand (COD), and 
phosphate. 

 The biological processes for purification of the wastewater using different 
partial stages such as e.g. COD degradation, nitrification and denitrification 
sub-steps are complex and not easily modeled. Care must be taken that the 
bacteria, as living beings, are provided with the right environmental conditions 
so that they fulfill exactly the desired task with their metabolic processes. 

 Many of the variables important for closed-loop control, especially 
concentrations, are not measured online but are available only at longer 
intervals as lab samples. 

 The influent to a wastewater treatment plant is subject to strong fluctuations – 
both in terms of quantity and its contents. This is due to weather-related and 
seasonal fluctuations as well as the behavior of the high numbers of private 
households and industrial companies that discharge wastewater to the sewer 
network. 

 Wastewater treatment plants and, in particular, the aeration of biological 
purification steps, represent the largest communal energy consumer in many 
cities and municipalities. Measures that reduce energy consumption can 
therefore pay for themselves after a short time. 

 Based on the typical size of mainly municipal wastewater treatment plants, 
engineers with relevant know-how about wastewater-specific, biotechnological 
issues are usually available on-site, but not control engineers. That is why any 
control engineering solution must have a clear and transparent structure so 
that it can be operated and maintained by the available personnel. 

The use of instrumentation and control (I & C) technology in wastewater treatment 
plants has the following basic objectives: 

 Improvement of purification performance for compliance with discharge limits. 

 Minimization of operating costs, especially energy costs. 

 Saving of investment costs through optimal use of existing infrastructures. 
(Whitepaper "Optimization of Wastewater Treatment Plants with Advanced 
Process Control" \9\.) 
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The configuring of the plant is in accordance with the physical model of the 
DIN EN 61512 or ISA 196 standards. This specifies the lower four levels, i.e. plant, 
unit, technical systems and control module. On the three lower levels pre-built, 
re-usable solutions can be employed: Process tag types (“Control Modules”) 
on the control module level, Equipment Modules on the technical system level and 
“Unit Templates” on the unit level. 

1.2 Solution 

1.2.1 The Biological Stage of a Wastewater Treatment Plant with 
intermittent Operating Mode 

The application example "PCS 7 Unit Template – Control of Biological Stage 
Wastewater Treatment Plant with intermittent operation" (referred to below as 
the "Biological Stage") is a Unit Template for waste water treatment plants, which 
can be integrated as a plant section in the most diverse sewage treatment plants. 

The Unit Template provides a template that comprises all typical components, their 
open- and closed-loop control, the necessary logic and interlocks as well as the 
visualization. The template design is modular and based on standardized 
functions. Its utilization offers the following advantages: 

 A reduction of the knowledge necessary to develop applications. 

 A decrease in the engineering effort 

 A reduction of the technical risk. 

 More flexible setup and adaptations through equipment modules. 

 Standardized structures. 
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1.2.2 Overview of the complete Solution 

Diagram 

The following figure shows a typical layout of a wastewater treatment plant that 
operates an activated sludge process in intermittent mode. For an easy-to-
understand explanation of the activated sludge process, see the white paper 
"Optimization of Wastewater Treatment Plants with Advanced Process Control" \9\. 

 

Figure 1-1 Process flow diagram of a typical wastewater treatment plant with intermittent 
operating mode. The biological stage is marked in red. 
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Description 

The Unit Template "Biological Stage" includes several pre-built, unified and ready-
connected equipment modules. From this sample solution, numerous instances 
can be generated with different parameter assignments and adapted structure to 
be widely integrated in different automation solutions. The PCS 7 project is 
configured to be hardware-independent and can be flexibly incorporated in existing 
projects. 

The Unit Template "Biological Stage" has been realized as a PCS 7 multiproject, 
as follows: 

 One project for the automation system (AS) and one project for the operator 
station (OS) are contained in the component view. 

 In the plant hierarchy (technological view), a hierarchy folder is created for 
each equipment module of the biological treatment. 

In the AS project, all open- and closed-loop control functions are implemented in 
form of CFC (Continuous Function Chart) and SFC (Sequential Function Charts). 
Furthermore, the AS project also contains a hierarchy folder with simulation charts 
that simulate a biological process, e.g. a concentration change, within 
an equipment module. 

All the control modules are available in the project's master data library as Control 
Module Type (CMT) and contain function blocks of the PCS 7 Advanced Process 
Library (APL) and of the Industry Library (IL). 

The OS project contains the visualization of the biological stage with all the 
equipment modules and shows: 

 A schematic structure of the biological stage of a wastewater treatment plant 
with intermittent operating mode. 

 The relevant parameters (KPI: Key Performance Indicators) 

 The sequence control of a continuous treatment process with alternating 
phases of nitrification and denitrification. 

Delimitation 

The chemical and micro-biological processes in the unit are not simulated in detail; 
they are only approximately described by schematic linear behavior model. After 
the simulation has been extended, the Unit Template could also be used within the 
framework of an operator training system. 

Required knowledge 

Fundamental knowledge of the following specialist fields is a prerequisite: 

 PCS 7 Engineering and APL 

 Knowledge of control system technology 

 Basic knowledge of process technology 
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1.2.3 Core Functionality 

In the following section, you can find a description of the individual components of 
the biological stage of a wastewater treatment plant. The entry point is the process 
picture of the PCS 7 operator station (OS). 

 

Figure 1-2 Process picture of the biological stage, above: OS operating screen, below: Variant for 
parameter assignment of simulation model  

 

 

Process picture 

The process picture of the biological stage consists of the following components: 

 Schematic representation 

 Faceplates for controlling the individual plant components  

 Overview of the relevant parameters (Key Performance Indicators) and 
operating time display 

In the process picture, the operator will find an overview of the entire plant section 
and the operating elements for his interventions. 
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Process-specific parameter settings 

In the underlying process settings in the simulation picture, technical data is 
predefined for the operating point of the biological stage. In addition, the rated 
outputs of drives, technical specifications and maximum values are pre-defined. 
These settings affect both the simulation and the KPI calculations. 

 

1.2.4 Description of the individual Functions 

Figure1-3 Components of the wastewater treatment plant 

 

 

The process picture of the biological treatment consists of the following major 
components: 

1. Inlet 

2. Aeration tank 

3. Aeration 

4. Agitator 

5. Return sludge 

6. Excess sludge discharge 

7. Secondary clarifier 

8. Purified water 

Inlet (1) 

The mechanically pre-cleaned wastewater (by means of screen, sand trap and 
preliminary sedimentation tank) enters the aeration basin via the feed pipe. The 
actual feed flow rate is regarded as a measurable disturbance variable in the 
higher-level model-predictive controller (MPC). 

Aeration tank (2) 

The ammonium concentration (NH4) in the aeration tank is regulated by means 
of an MPC during the nitrification phase. The revolution speed of the fresh-air 
blower is used as the manipulated variable of the MPC. The manipulated variable 
is used as setpoint input for the lower-level motor control module. Denitrification 
phase and Nitrification phase follow each other in a sequential manner in the 
aeration tank. 

1 

2 

3 

4 

5 

6 

7 

8 
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Aeration (3) 

Fresh air is pumped into the aeration tank (during the nitrification phase). 

The blower receives its set-point from the MPC in the aeration tank. The energy 
consumed by the blower in kWh is calculated in a separate CFC plan. 

Agitator (4) 

The agitator ensures thorough mixing of wastewater and activated sludge in 
the aeration tank (during the denitrification phase in which good mixing cannot 
be guaranteed by the air flowing in from below). 

Return sludge (5) 

The return sludge is the activated sludge that settles at the bottom of 
the secondary clarifier and is returned to the aeration tank. 

The return flow of activated sludge (controlled variable) is regulated by the 
rotational speed of a pump (manipulated variable) by a PID controller. The return 
sludge is fed to the inlet in a defined ratio ("return sludge ratio"). 

Excess sludge discharge (6) 

The excess sludge that forms in the secondary clarifier  due to bacterial growth is 
not pumped back to the aeration tank but removed from the biological treatment 
and then typically processed for energy generation in a biogas plant. 

Secondary clarifier (7) 

The activated sludge is separated from the purified water by a settling process in 
the secondary clarifier. Most of the activated sludge is then fed back to the aeration 
tank. 

Discharge (8) 

The purified water is usually introduced into a public flowing water (e.g. river). 

Additional functions 

After starting the PLC and the unit, an SFC drives the biological treatment to the 
operating point. 

Parameters (KPI = Key Performance Indicators) 

The following key performance indicators are measured or calculated: 

 Blower electrical power 

 Blower energy consumption (essential for operating costs) 

 Total nitrogen load (relevant for wastewater quality) 

Note The PCS 7 project can be expanded by means of individual KPI calculations, 
such as the electrical power rating of its return sludge pump. 

Operating hours counter 

The operating hours counter for the air intake motor, the return sludge pump and 
the agitator are contained in the process picture and can be used for maintenance 
planning. 
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1.2.5 Background Information: Process Optimization in Terms of Energy 
Consumption and Wastewater Quality 

Up to now it has been common practice in sewage treatment plants with 
intermittent denitrification to determine a constant oxygen level that is maintained 
by means of a PI controller via a blower. However, the typical duration of the 
nitrification phase is not always sufficient for the oxygen controller to reach 
a steady-state oxygen concentration by varying the blower speed. At the same 
time, the blower speed at the start of the nitrification phase is very high, which 
wastes a significant amount of energy. 

The influent flow rate has a considerable effect on the dynamic processes in the 
sewage treatment plant. However, the common automation cannot react directly to 
a change because the influent flow rate is not taken into account in conventional 
closed-loop control. It is only when a change in the concentrations in the activated 
sludge tank occurs that the phase durations are changed and the oxygen controller 
adjusts the blower speed as needed. 

The new solution concept described in this article is based on the insight that 
oxygen concentration in the nitrification phase is only an auxiliary controlled 
variable for providing the right environmental conditions for aerobic metabolism 
of bacteria. An oxygen concentration that is constant over an extended period 
cannot always be achieved, but it is also not necessary for process control. 

In the concept presented here, therefore, the blower speed is controlled directly by 
the process variable of primary interest, that is, ammonium concentration. This is 
supposed to drop from an initial value at the start of the nitrification phase to a 
specified target value within a specified time in order to end the nitrification phase. 
The biggest energy consumers in the wastewater treatment plant are the blowers 
for the aeration. In comparison to them, the energy consumption of the return 
sludge pumps is negligible. The considerable potential energy savings by the MPC 
solution are based mainly on increasing the aeration slowly in a requirement-
compliant manner at the beginning of the nitrification phase, that is, to blow in only 
as much air as the bacteria actually need for their aerobic metabolism.  

At the same time, the influent flow rate is interpreted as a measurable disturbance 
variable. If the effects on the processes in the nitrification phase are known, the 
controller can adjust the aeration in good time and in an anticipatory manner, 
preventing, or at least reducing the negative effects of influent fluctuations. 

The MPC function “ModPreCon” block is ideally suited for the described tasks. It 
has a setpoint filter that can determine the desired time trajectory of the ammonium 
concentration by specifying a transient time. 

Due to the above-described limitations of the PI controller the MPC is not cascaded 
with the existing oxygen controller. This is why the MPC uses the blower speed 
directly as the manipulated variable in order to control the ammonium 
concentration while taking into account the measurable disturbance variable “feed”. 

Source: Whitepaper \9\. 
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1.2.6 Control Concept 

Wastewater quality control during clarifying sequence is performed by regulating 
the ammonium (NH4) and nitrate (NO3) concentrations. The switching between the 
nitrification and denitrification phases serves this purpose. Switchover takes place 
when threshold values are undercut. The nitrification phase is ended as soon as 
the ammonium concentration drops below a threshold value of 0.5 mg/L, meaning 
that enough ammonium has been degraded  (to nitrate) through nitrification. The 
denitrification phase is ended as soon as the nitrate concentration drops below a 
threshold value of 0.8 mg/L indicating that enough nitrate has been degraded 
through denitrification. The switchover logic is supplemented with minimum and 
maximum phase durations to prevent excessively fast changeovers and 
excessively long dwell times. 

The aeration control loop during the nitrification phase represents the second 
part of the closed-loop control. The blower revoltuion speed (manipulated variable) 
is directly adjusted with respect to the process value of primary interest, that is, the 
ammonium concentration (controlled variable). Control is implemented via the MPC 
function block “ModPreCon” of the APL. 

The PID controller "PIDConL" of the APL is used for control of return sludge. 
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1.2.7 P&I Diagram 

The following figure shows the elements of the biological treatment in a piping and 
instrumentation diagram. 
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1.3 Hardware and Software Components 

The application example has been created with the following components: 

Hardware components 

 

Component Note 

SIMATIC PCS 7 ES/OS IPC847D W7 For the PCS 7 V8.1 SP1 example project 

 

Note In case of different hardware, please take heed of the minimum requirements for 
installing the software components. The minimum requirements can be found in 
the Readme file of the PCS 7. 

 

Standard software components 

 

Component Note 

SIMATIC PCS 7 V8.1 SP1 Part of SIMATIC PCS 7 ES/OS IPC847D W7 

S7 PLCSIM The license does not form part of SIMATIC 
PCS 7 ES/OS IPC847D W 7 

APL library Part of SIMATIC PCS 7 V8.1 SP1 

SIMATIC Industry Library (V8.1 SP1) Not a part of SIMATIC PCS 7 V8.1 SP1 

CFC V8.1 SP1 Update 3 Not a part of SIMATIC PCS 7 V8.1 SP1 

 

Note For information on the Service Pack 1 for SIMATIC PCS 7 Industry Library V8.1, 
see the following link: 
https://support.industry.siemens.com/cs/ww/en/view/109477851 

Specific control module types for the water industry are taken from the Industry 
Library: WCMT (“Water Control Module Type”) \4\. 

 

Example files and projects 

The following list contains all the files and projects used in this example. 

 

File Note 

109485916_PROJECT_ASUC_PCS7_V811.zip PCS 7 V8.1 SP1 example project 

109485916_DOCU_ASUC_PCS7_V811_en.pdf This document 

 

https://support.industry.siemens.com/cs/ww/en/view/109477851
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2 Structure and Principle of Operation 

2.1 Project Structure 

2.1.1 Naming Convention of CFC 

A uniform naming convention is used for identifying the control modules, whereby 
the function has been named according to European standard EN 62424. The 
following figure shows the composition of a process tag. 

FFIC_RetSludge

Function

F = Flow rate (first letter)

F = Ratio (subsequent letter)

I = Indication (subsequent letter)

C = Control (subsequent letter)

Designation

 

 

The following table contains the letters used in the Application Example and their 
meaning. 

 

First letter Meaning 

F Flow 

Q Quality, Concentration 

N Motor speed 

 

Subsequent letter Meaning 

C Control – Controllers 

I Indication 

F Fraction 

S Binary control function or switching function 
(not safety-oriented)  

 

2.1.2 Technological View 

In the technological view, the Unit Template "Biological Stage of a sewage 
treatment plant with intermittent operation" is realized in three hierarchy levels. 

In the first hierarchy level of the AS project "WWTP_AS" there is a CFC for the 
activation of the system, a CFC for the detection of the KPIs, and an SFC  to start 
the unit template (because these functions cannot be assigned to individual 
equipment modules). In the lower hierarchy level, there is a hierarchy folder with 
the necessary CFCs and SFCs for each equipment module of the biological 
treatment. The "Simulation" hierarchy folder contains the CFCs and the SFCs 
needed for simulation. 

In the first hierarchy level of the OS project “WWTP_OS" the "BiologicalTreatment" 
folder with the "BiologicalTreatment.pdl" process screen of the biological stage is 
located. The lower-level hierarchy folder "Simulation" contains the process picture 
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“Simulation.pdl”, in which process-specific settings for the simulation model can be 
made. 

The following figure is a simplified depiction of the PCS 7 multiproject structure: 
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2.2 Equipment Modules and Control Modules 

The "Biological Stage" Unit Template consists of pre-made equipment modules 
and control modules, for example, for the process simulation. In a PCS 7 project, 
both the individual control modules and the control modules inside equipment 
modules are based on control module types (CMTs) from the master data library. 
You will find the application descriptions "Standard PCS 7 and S7 Water 
Templates for the water industry" and "Equipment Modules for PCS 7 using the 
example of the Chemical Industry" as well as the example projects with the 
individual equipment modules and CMTs at the entry ID: 

 78604785 “Standard PCS 7 Water Templates for the water industry ”\4\ 

 53843373 "Equipment Modules for PCS 7 using the example of the Chemical 
Industry” \5\ 

The application example "Biological Stage" includes the following equipment 
modules: 

 Feed: Feed rate measurement for feedforward control and set point 
specification for return sludge 

 Aeration tank: Mixing in aeration tank by agitator and closed-loop control of 
ammonium and nitrate concentrations 

 Aeration (air): Blowers for aeration of the aeration tank  

 Return sludge (RetSludge): Return sludge flow control 

 Sequences (SFCs) for starting the system and intermittent operation of 
aeration tank 

 Overall process simulation (Process Simulation), in addition to the simple 
simulations which are already integrated in the control module types. 

 Process key performance indicators (KPI) 

In the following sections you will find the setup of the specific equipment modules 
as well as the extension and modifications made vis-à-vis the original equipment 
modules used and the original CMTs. In addition the SFCs for startup 
and operation of the wastewater treatment plant are described. 

https://support.industry.siemens.com/cs/ww/en/view/78604785
https://support.industry.siemens.com/cs/ww/en/view/53843373
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2.3 Feed 

The (mechanically) pre-cleaned wastewater enters the aeration basin via the feed 
pipe. The control module type "WCMT_MonAnalog" of the master data library for 
the water industry serves for monitoring of the feed flow. 

2.3.1 Setup 

The following table provides an overview of the elements and control module types 
used. 
 

Designation Control module type Use 

FI_Feed WCMT_MonAnalog Measurement of  feed flow 

2.3.2 Parameter Assignment 

Measuring point “FI_Feed” is an instance of control module type 
“WCMT_MonAnalog” with selected variant “MonAnIn”, i.e. the optional module 
MonAnIn is effectively built into the instance. The measuring point "FI_Feed" 
serves to record the wastewater inlet flow. In contrast to the real plant, in this 
application example the process value input is set by the operator or the SFC. 
The measuring point "FI_Feed" transmits the process value as a disturbance 
variable to the MPC control module "QIC_NH4". 

The following table provides a summary of parameter settings an interconnections 
to other control modules: 

 

Block Connection Value Use 

MonAnIn Scale 5.0 Maximum value of the process value 

MonAnIn PV_Unit 1347 Process value unit (m³/h) 

MonAnIn SimOn 1 Simulated process value active 

MonAnIn SimPV_In  Interconnection for the simulated 
process value 
(Sim_Feed\SimFeed.SP_Out) 

MonAnIn PV_Out  Interconnection to MPC 
(QIV_NH4\NitroMPC.DV1) 

MonAnalog PV_Out  Interconnection to Return Sludge 
(FFIC_RetSludge\Ratio_RetSludge.In; 
FFIC_RetSludge\Ratio_RetSludge.InPV) 
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2.4 Aeration Tank (Activation) 

The MPC is applied for quality control by which the wastewater quality (i.e. 
ammonium concentration (NH4)) is adjusted according to legal limits for permissible 
nitrogen discharge into public waterways. In nitrification phase the MPC commands 
the setpoint value for the aeration revolution speed. During the denitrification phase 
both regulation and ventilation are deactivated. In addition the agitator is activated 
for mixing of wastewater and activated sludge. Switching over takes place using 
threshold values and timeframes, via an SFC. For a detailed description of the 
SFC, please refer to Chapter 2.8 “Sequences (SFC)”. 

Setup 

Water quality (ammonium concentration (NH4)) is controlled by means of the MPC 
“QIC_NH4”. The controller receives the current measured value of the controlled 
variable (ammonium concentration (NH4)) and the disturbance variable 
(wastewater feed) and calculates a setpoint for the aeration revolution speed. 
Water quality nitrate concentration (NO3) is controlled by means of the minimum 
holding time determined by the SFC “NitriDenitri” and the threshold value – it is not 
a continuous feedback control with a permanent tallying between setpoint and 
actual values. In the denitrification phase, mixing must be ensured by the agitator, 
whereas in the nitrification phase it is achieved by the spatially distributed injection 
of air through the floor of the tank. The control variables are visualized with the 
measuring points "QI_NH4" and "QI_NO3". The agitator is controlled via the control 
module “NS_Activation”. Additionally, oxygen concentration in the aeration tank is 
visualized via the “QI_O2” measuring point. 

The following table provides an overview of the elements and control module types 
used. 
 

Designation Control module type Description 

QIC_NH4  MPC serves as controller for 
ammonium concentration 

QI_NH4 WCMT_MonAnalog Measuring point for displaying 
ammonium concentration 

QI_NO3 WCMT_MonAnalog Measuring point for displaying 
nitrate concentration 

QI_O2 WCMT_MonAnalog Measuring point for displaying 
oxygen concentration 

NS_activation WCMT_MotLean Mixing in the aeration tank 

NitriDenitri  SFC for sequential control of 
clarification in aeration tank 

 

Note The measured values of QI_NH4 and QI_NO3 always provide the concentration 
of ammonium-nitrogen or nitrate-nitrogen in the water and are therefore referred 
to as NH4-N and NO3-N, respectively. 
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2.4.1 Parameter Assignment 

NS_activation 

The agitator, which is actuated by the control module "NS_Activation", mixes 
together the feed that flows into the aeration tank and the return sludge. In the 
Application Example, the operator or the SFC chart “NitriDenitri” is responsible for 
the control of the measuring point. Measuring point “NS_Activation” is an instance 
of the control module “WCMT_MotLean” with the following select variants: 

 Count 

 OutStart 

The following table shows the interconnections for other measuring points and 
parameters: 

 

Block Connection Value Use 

FbkRun SimOn 1 Simulated process value active 

FbkRun SimPV_In  Interconnection to simulated 
process value 
(Sim_NS_Activation\SimFbkRu.Out) 

LocalStop Sim_On 1 Simulated process value active 

StartOut Sim_On 1 Simulated process value active 

StartOut SimPV_In  Interconnection for the simulated 
process value 
(NS_Activation\Motor.Start) 

Motor StartAut  Start in automatic mode 
(interconnection for SFC chart) 

Motor StopAut  Stop in automatic mode 
(interconnection for SFC chart) 

Motor ModLiOp  Switchover of operating mode 
selection (interconnection to SFC 
chart) 

Motor AutModLi  Automatic mode via interconnection 
(interconnection to the SFC chart) 

Motor Start  Signal for starting the motor 
(interconnection to 
Sim_NS_Activation\SimFbkRu.In) 

Motor FbkRunOut  Motor started feedback message 
(interconnection to SFC chart) 

QIC_NH4 

The following relevant values are used and interconnected for quality control with 
MPC measuring point “QIC_NH4”: 

 Controlled variable (CV) Ammonium concentration (NH4) 

 Manipulated variable (MV) blower revolution speed 

 Disturbance variable (DV) feed volume 
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The following table shows the interconnections for other measuring points and 
parameters: 
 

Block Connection Value Meaning 

NitroMPC CV1  Process value: controlled 
variable 
(QI_NH4\MonAnIn.PV_Out) 

NitroMPC DV  Process value: disturbance 
variable 
(FI_Feed\MonAnIn.PV_Out) 

NitroMPC SP1 0.4 Controlled variable setpoints 

NitroMPC PreFilt1 300.0 Transient recovery time (s) of 
the setpoint filter for setpoint 
SP1 

NitroMPC MV1Man  Manipulated variable in setup 
mode 

NitroMPC MV1ManLoLim 40.0 Lower limit of setpoint value 
in manual operation 

NitroMPC AutModLi  Automatic mode 
via interconnection 
(interconnection to the SFC 
chart) 

NitroMPC ManModLi  Manual mode 
via interconnection 
(interconnection to the SFC 
chart) 

NitroMPC ModLiOp  Switchover of operating mode 
selection (interconnection to 
SFC chart) 

NitroMPC CV1_Unit 1558 Measurement unit controlled 
variable (mg/l) 

NitroMPC MV1_Unit 1342 Measurement unit manipulated 
variable (mg/l) 

NitroMPC DV_Unit 1347 Unit of measurement of 
disturbance variable (m

3
/s) 

NitroMPC DB_No 1 Number, data block with 
parameter data sets 

NitriMPC MV1  Manipulated variable value 
(NC_O2\MotSpdContr.SP_Ext) 

 

In a real system, the parameters of the MPC are assigned using learning data by 
means of the MPC configurator. The general procedure is described in detail in 
the Application Example “Model-based Predictive Multi-variable Control using 
a Distillation Column as an Application Example" \10\. 

The concrete implementation of the simulated aeration tank is documented in 
Chapter 2.11. "MPC Configuration". 

QI_NH4 

The display measuring point "QI_NH4" is used for detecting and displaying the 
ammonium concentration (control value) of the MPC measuring point. Measuring 
point “QI_NH4” is an instance of control module type “WCMT_MonAnalog” with 
selective variant “MonAnIn”. 
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The following table provides a summary of the interconnections for other 
measuring points and parameters of the included blocks: 
 

Block Connection Value Use 

MonAnIn Scale 10.0 Maximum value of 
the process value 

MonAnIn PV_InUnit 1558 Process value unit (mg/l) 

MonAnIn SimOn 1 Simulated process value 
active 

MonAnIn SimPV_In  Interconnection for the 
simulated process value 
(SimNitriDentri\Sim_NH4.Out) 

MonAnIn PV_Out  Interconnection to MPC 
and KPI 
(QIC_NH4\NitroMPC.CV1; 
KPI\ActTKN.In1) 

MonAnalog PV_Out  Current process value 
(interconnection for SFC 
chart) 

MonAnalog PV_AH_Lim 9.9 Limit PV alarm (high) 

MonAnalog PV_WH_LIM 9.5 Limit PV warning (high) 

 

QI_NO3 

The display measuring point "QI_NO3" is used for detecting and displaying the 
nitrate concentration. Measuring point “QI_NO3” is an instance of control module 
type “WCMT_MonAnalog” with selective variant “MonAnIn”. 

The following table provides a summary of the interconnections for other 
measuring points and parameters of the included blocks: 
 

Block Connection Value Use 

MonAnIn Scale 5 Maximum value of 
the process value 

MonAnIn PV_InUnit 1558 Process value unit (mg/l) 

MonAnIn SimOn 1 Simulated process value 
active 

MonAnIn SimPV_In  Interconnection for the 
simulated process value 
(SimNitriDentri\Sim_NO3.Out) 

MonAnIn PV_Out  Interconnection to MPC 
and KPI 
(QIC_NH4\NitroMPC.CV1; 
KPI\ActTKN.In2) 

MonAnalog PV_Out  Current process value 
(interconnection for SFC 
chart) 

MonAnalog PV_AH_Lim 10.0 Limit PV alarm (high) 

MonAnalog PV_WH_LIM 9.5 Limit PV warning (high) 



2 Structure and Principle of Operation 

 

 

Biological stage of a wastewater treatment plant 
Entry ID: 109485916,    V1.0,    07/2016   24 
 


 S

ie
m

e
n

s
 A

G
 2

0
1

6
 A

ll 
ri

g
h

ts
 r

e
s
e

rv
e

d
 

QI_O2 

The display measuring point "QI_O2" is used for detecting and displaying the 
oxygen concentration. The measuring point "QI_O2" is an instance of measuring 
point type “WCMT_MonAnalog” with activated variant “MonAnIn”. 

The following table provides a summary of the interconnections for other 
measuring points and parameters of the included blocks: 
 

Block Connection Value Use 

MonAnIn Scale 5 Maximum value of 
the process value 

MonAnIn PV_InUnit 1558 Process value unit (mg/l) 

MonAnIn SimOn 1 Simulated process value 
active 

MonAnIn SimPV_In  Interconnection for the 
simulated process value 
(Sim_O2\Gain_Sim_O2.Out) 

 

2.5 Aeration (Air) 

The aeration is affected by a continuous control of the drive speed during the 
nitrification phase. The drive controls a blower that blows a speed-dependent 
quantity of fresh air and thus oxygen from below into the aeration tank. 

2.5.1 Setup 

The MPC measuring point "QIC_NH4" acquires the ammonium concentration 
(NH4) and controls it via the revolution speed of the blower. 

The following table provides you with an overview of the elements and control 
module types used: 
 

Designation Control module type Use 

NC_O2 WCMT_MotSpdCon Blower revolution speed 

2.5.2 Parameter Assignment 

The motor measuring point "NC_O2" controls the rotational speed of the fresh air 
blower to the aeration tank and thus the oxygen concentration in the aeration tank. 
The motor block receives its external setpoint from the controller measuring point 
"QIC_NH4".  

Measuring point "NC_O2" is an instance of the "WCMT_MotSpdCon” control 
module type with the following select variants: 

 Count 

 FbkFwd 

 OutFwd 

 OutSpeed 

 RbkSpeed 
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The following table provides a summary of the interconnections for other 
measuring points and parameters of the included blocks: 
 

Block Connection Value Use 

FbkFwd SimOn 1 Simulated process value active 

FbkFwd SimPV_In  Interconnection for the simulated 
process value 
(Sim_NC_O2\SimFbkFwd.Out) 

RbkSpeed SimOn 1 Simulated process value active 

RbkSpeed SimPV_in  Interconnection for the simulated 
process value 
(Sim_NC_O2\MotorRun) 

MotSpeedContr FwdAut  Forward operation in automatic 
mode (interconnection for 
SFC chart) 

MotSpeedContr StopAut  Stop in automatic mode 
(interconnection for SFC chart) 

MotSpeedContr ModLiOp  Switchover of operating mode 
selection (interconnection 
to  SFC chart) 

MotSpeedContr AutMotLi  Automatic mode via interconnection 
(interconnection to the SFC chart) 

MotSpeedContr SP_Ext  External setpoint 
(QIC_NH4\NitroMPC.MV1) 

MotSpeedContr SP_LiOp  Select setpoint source via 
interconnection (interconnection 
to the SFC chart) 

MotSpeedContr SP_ExtLi  External setpoint via 
interconnection (interconnection 
to the SFC chart) 

MotSpeedContr SP_IntLi  Internal setpoint via interconnection 
(interconnection to the SFC chart) 

MotSpeedContr Fwd  Control forward 
(Sim_NC_O2\SimFbkFwd.In 

MotSpeedContr ManAct  Manual operation active 
(interconnection for SFC chart) 

MotSpeedContr FbkFwdOut  Feedback signal, forward operation 
(interconnection for SFC chart) 

MotSpeedContr SP_Out  Setpoint used 
(Sim_NC_O2\SimRbkSpeed.In; 
Interconnection for SFC chart) 

MotSpeedContr Rbk_Out  Feedback value (interconnection 
for SFC chart) 

OutFwd SimOn 1 Simulated process value active 

OutFwd SimPV_In  Interconnection for the simulated 
process value 
(NC_O2\MotSpeedContr.Fwd) 

OutSpeed SimOn 1 Simulated process value active 

OutSpeed SimPV_In  Interconnection for the simulated 
process value 
(NC_O2\MotSpeedContr.SP_Out) 
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2.6 Return activated Sludge (RetSludge) 

The return activated sludge is affected by the continuous control of the drive 
speed. The drive impels a pump that conveys an rpm-dependent quantity of return 
activated sludge into the aeration tank. The equipment module includes three 
measuring points for control, drive and display. 

Setup 

The display measuring point “FI_Feed” (from the equipment module Inflow) 
acquires the sewage feed volume. The measured value is transmitted to the 
controller measuring point "FFIC_RetSludge". A fixed ratio ("return activated 
sludge ratio") between feed volume and return activated sludge volume is set there 
with the help of the ratio module "Ratio_RetSludge" and used to calculate an 
external setpoint for the slave controller. The slave controller records the volume of 
return activated sludge and requires either an increase or a decrease in the pump 
revolution speed, depending on the specified return activated sludge volume. 

The following table provides you with an overview of the elements and control 
module types used: 
 

Designation Control module type Use 

FFIC_RetSludge WCMT_PIDConL Return activated sludge volume 
control 

FI_RetSludge WCMT_MonAnalog Measuring point for the volume 
of return sludge 

NC_RetSludge WCMT_MotSpdCon Pump drive rotational speed 

 

2.6.1 Parameter Assignment 

FFIC_RetSludge 

In the measuring point "FFIC_RetSludge", the volume of activated sludge returned 
to the aeration tank is regulated. The current return activated sludge volume is 
recorded in the measuring point "I_RetSludge" and transmitted to the measuring 
point "FFIC_RetSludge". The setpoint entry is specified via the display measuring 
point "FI_Feed" and the "Ratio_RetSludge” ratio module. The measuring point 
"FI_Feed" transmits the measured value of the sewage feed to the 
"Ratio_RetSludge" ratio module. The ratio value formed there is transmitted to 
the controller as a setpoint. The measuring point "FFIC_RetSludge" transmits the 
manipulated variable to the drive of the "NC_RetSludge” pump. "FFIC_RetSludge" 
is an instance of the "WPTT_PIDConL" control module type, extended to include 
the "Ratio" module. 
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The following table provides a summary of the interconnections for other 
measuring points and parameters of the included blocks: 
 

Block Connection Value Use 

Ratio_RetSludge In  Analog input (FI_Feed\MonAnIn.Out) 

Ratio_RetSludge InUnit 1347 Process value unit (m
3
/s) 

Ratio_RetSludge InPV  Process variable 
(FI_Feed\MonAnalog.PV_Out) 

Ratio_RetSludge SecComPV  Process value of secondary components 
(FI_RetSludge\MonAnalog.PV_Out) 

Ratio_RetSludge SecComUnit 1347 Secondary components unit (m
3
/s) 

Ratio_RetSludge RatioExt  External ratio (interconnection for 
SFC chart) 

Ratio_RetSludge RatOpScale 2.0 Limit value for bar display scale in image 
module 

Ratio_RetSludge RatHiLim 2.0 Upper ratio limit value 

Ratio_RetSludge OutHiLim 64.8 Limit (high) for initial value 

Ratio_RetSludge RatLiOp  Selection of ratio source (interconnection 
for SFC chart) 

Ratio_RetSludge RatExtLi  External ratio value via interconnection 
(interconnection to the SFC chart) 

PIDCon Gain 0.436 Controller gain 

PIDCon NormPV 10.0 Normalizing the proportional gain (Gain) 

PIDCon TI 1.63 Controller adjustment time 

PIDCon SP_LiOp  Setpoint source internal/external 
(interconnection for SFC chart) 

PIDCon PV  Process value: controlled variable 
(FI_RetSludge/MonAnalog.PV_Out) 

PIDCon ModLiOp  Switchover of operating mode selection 
(interconnection to SFC chart) 

PIDCon MV  Manipulated variable value 
(NC_RetSludge\MotSpdContr.SP_Ext) 

PIDCon ManHiOut  Limit (high) for manual operation 
(NC_RetSludge\MotSpdContr.SP_HiLim) 

PIDCon ManLoOut  Limit (low) for manual operation 
(NC_RetSludge\MotSpdContr.SP_LoLim) 

PIDCon AutAct  Automatic operating mode active 
(interconnection for SFC chart) 

PIDCon SP_ExtAct  External setpoint active (interconnection 
for SFC chart) 
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NC_RetSludge 

The motor measuring point "NC_RetSludge" controls the return volume of activated 
sludge into the aeration tank via the drive speed. The motor module receives its 
external setpoint from the controller measuring point "FFIC_RetSludge". 

"NC_RetSludge" is an instance of the "WCMT_MotSpdCon” control module type 
with the following select variants: 

 Count 

 FbkFwd 

 OutFwd 

 OutSpeed 

 RbkSpeed 

The following table shows the interconnections for other measuring points and 
parameters of the included blocks: 
 

Block Connection Value Use 

FbkFwd SimOn 1 Simulated process value active 

FbkFwd SimPV_in  Simulated process value 
(Sim_NC_RetSludge\dimFbkFwd.Out) 

RbkSpeed PV_InUnit 1342 Process value unit (%) 

RbkSpeed SimOn 1 Simulated process value active 

RbkSpeed SimPV_In  Simulated process value 
(Sim_NC_RetSludge\SimRbkSpeed.Out) 

MotSpeedContr FwdAut  Forward operation in automatic mode 
(interconnection for SFC chart) 

MotSpeedContr ModLiOp  Switchover of operating mode selection 
(interconnection to SFC chart) 

MotSpeedContr AutMotLi  Automatic mode via interconnection 
(interconnection to the SFC chart) 

MotSpeedContr SP_Ext  External setpoint 
(FFIC_RetSludge\PIDCon.MV) 

MotSpeedContr SP_LiOp  Select setpoint source via 
interconnection (interconnection to the 
SFC chart) 

MotSpeedContr SP_HiLim  High setpoint limit 
(FFIC_RetSludge\PIDCon.ManHiOut) 

MotSpeedContr SP_LoLim  Low setpoint limit 
(FFIC_REtSludge.PIDCon.ManLoOut) 

MotSpeedContr Fwd  Control forward 
(Sim_NC_RetSludge\SimFbkFwd.In 

MotSpeedContr AutAct  Automatic operation active 
(interconnection for SFC chart) 

MotSpeedContr SP_Out  Setpoint used 
(Sim_NC_O2\SimRbkSpeed.In) 

MotSpeedContr Rbk_Out  Readback value 
(FFIC_RetSludge/PIDCon.MV_Trk) 

CascaCut Out  Control sequence to controller 
interrupted 
(FFIC_RetSludge\PIDCon.MV_TrkOn) 

OutFwd SimOn 1 Simulated process value active 
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Block Connection Value Use 

OutFwd SimPV_In  Simulated process value 
(NC_RetSludge\MotSpdContr.Fwd) 

OutSpeed SimOn 1 Simulated process value active 

OutSpeed SimPV_In  Simulated process value 
(NC_RetSludge\MotSpdContr.SP_Out) 

 

FI_RetSludge 

The display measuring point "FI_RetSludge" uses the simulated value for the 
volume of the return activated sludge from the simulation chart "Sim_RetSludge". 
Measuring point “FI_RetSludge” is an instance of control module type 
“WCMT_MonAnalog” with selective variant “MonAnIn”. 

The following table provides a summary of the interconnections for other 
measuring points and parameters of the included blocks: 
 

Block Connection Value Use 

MonAnIn Scale 100.0 Maximum value of the process value 

MonAnIn PV_InUnit 1347 Process value unit (m
3
/h) 

MonAnIn SimOn 1 Simulated process value active 

MonAnIn SimPV_In  Interconnection for the simulated process value 
(Sim_RetSludge\Gain.Out) 

MonAnalog PV_Out  Process value 
(FFIC_RetSludge\Ratio_RetSludge.SecComPV; 
FFIC_RetSludge\PIDCon.PV) 

 

The "operable and monitorable" attribute is deactivated in the "MonAnalog" block 
because in the Application Example, the measuring point "FI_RetSludge" is only 
used for process value detection. The process value is displayed via the controller 
measuring point "FFIC_RetSludge". 
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2.7 Process Simulation 

The hierarchy folder "Simulation" contains the simulations of the individual plant 
units and the simulations that have a spanning character. 

Ammonium (NH4) and nitrate concentrations are simulated in the CFC 
“SimNitriDenitri”. A matrix with linear, dynamic transfer functions is used as 
a model for process simulation of the ammonium concentration (sheet 2). 
The process model is a 1x2 MISO system (Multi Input Single Output), where the 
influence of each input variable is simulated on each output variable by a separate 
partial transfer function. The model describes the temporal behavior of process 
deviations from the working point. The signs of the partial transfer functions are 
physically plausible. For example, an increase in the blower revolution speed (Air) 
leads to a reduction of the ammonium concentration (NH4), i.e. the partial transfer 
function from u1 to y1 has a minus sign. The time constants in the simulation, 
however, are significantly faster than in a real plant. Additionally, in real plants 
downtimes can also occur in the partial transfer functions. 

In the following figure, the process model is depicted with the corresponding 
designations. 

Air Feed

NH4 yu1 yu2

The partial transfer functions influence the respective output values (ammonium 
concentration (NH4)) with different dynamic models of the first order (PT1). 
Each partial transfer function receives the current value of the input variables 
and outputs them in accordance with its transfer functions at the output point. 
At the end the outputs of the partial transfer functions add up and generate the 
output value for ammonium concentration (NH4). The operating point of the 
ammonium concentration is defined at the PTn transfer function “Feed->NH4” 
at the “PVO” entry. 

Note All PTn transfer functions are structured as 'chart in chart' according to the same 
principle (ProcSimC of the APL), whereby only the required functional parts are 
activated. A transfer function contains three sequentially switched delay 
elements and a booster element. Furthermore, noise can be added to the 
output signal. 

 

Nitrate concentration is simulated via two simple balance equations (Sheet 1). 
The initial value is defined at the entry “OutTrk” in the integral module “NO3 
Concentratio”. The inflow and outflow terms of the balance equations are 
integrated, with nitrification and denitrification phases interchanged. 

Oxygen concentration is simulated via two simple balance equations in the 
“Sim_02” CFC. The inflow and outflow terms of the balance equations are 
integrated, with nitrification and denitrification phases interchanged. 
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The following figure shows sheet 2 for the CFC “SimNitriDenitri” for the calculation 
of the ammonium concentration. 

 

1. Operating point: 
In this module the operating point for ammonium concentration (output variable 
of the process model) is indicated. 

2. Controlled variable with operating point: 
In this module the ammonium concentration is calculated by adding the outputs 
of the individual transfer functions. 

1 

2 
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The following figure shows Sheet 1 for the calculation of the nitrate concentration. 

 

 

 

1. Operating point: 
The initial value of the nitrate concentration is adjusted at this point, the value 
that is adjusted when the binary entry OutTrkOn is set. 

2. Integrator for balance dimension: 
The nitrate concentration is calculated in this module by integrating the 
modification over time of the nitrate concentration. The integrator represents 
the reservoir for the mass of nitrate in the tank. 

3. The right-hand side of the balance equation during the denitrification phase 
represents the constant breakdown speed of nitrate to elementary nitrogen 
through the bacteria’s anaerobic metabolism. 

4. Balance equation during the nitrification phase represents the constant 
formation speed of nitrate from ammonium the bacteria’s aerobic metabolism, 
which depends on the aeration. 

You can adjust the numerical values for the initial value to the technical data of 
your plant without the dynamic response of the system being changed as a result. 

The simulation design for the oxygen concentration corresponds to the simulation 
design for the nitrate concentration. In the nitrification phase the change in the 
oxygen concentration depends on the aeration, in the denitrification phase it is 
constantly strongly negative, that is, the oxygen concentration drops very rapidly. 

 

Note No further physical or biological phenomena, such as the dependency of the 
bacterial metabolism on temperature, are considered in the simulation. The time 
constants in the simulation have been chosen to appear around 20 times faster 
than in real-time. 

The simple simulation in the template does not correspond to the simulation 
shown in the White Paper \9\. 

 

1 

2 

3 

4 
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2.8 Sequential Function Chart (SFC) 

Sequential function charts support the plant operator in starting up and shutting 
down a facility, and in the event of faults, and can be adapted to specific 
circumstances. 

The biological stage is designed for operation with continuous feed and intermittent 
aeration where individual parameters (e.g. feed volume) can change during 
operation. This application example includes the following sequences “Start”, 
“NitriDenitri” and “Sim_Feed_SFC”. 

Step sequence “Start” 

The Step sequence “Start” is the Step sequence to start up the biological stage 
of the wastewater treatment plant. It conducts the individual components of the 
system to the Operating point. 

The controllers are used with an external manipulated variable in the automatic 
operating mode and the drive in automatic mode. In the following transitions, 
the "Automatic" operating mode and control deviation are checked. 
 

Note With regard to real biological stages of wastewater treatment plants, this SFC 
can be considered only as a first reference point and was created to meet 
simulation requirements. For use in real systems, start-up controlling must be 
created according to the process-related requirements. 

The “Start” sequence automatically runs when the CPU is restarted. 

Step sequence “NitriDenitri” 

The step sequence “NitriDenitri” controls the nitrification and the denitrification 
phases in an alternating time sequence. As long as the sewage treatment plant is 
active there is an alternance back and forth between nitrification and denitrification 
phases.  

To start, the sequence checks whether the binary control “StartPlant/Plant OnOff” 
is set. The switched-on state of this binary control is thus a necessary but not 
sufficient condition for the start of the SFC. The SFC itself has to be started 
manually. However, it can be deactivated during the nitrification phase via binary 
control. 

Switch-over between the phases takes place depending on the threshold values 
for nitrate / ammonium concentration and minimum holding times 

In the denitrification phase: 

 the mixer is put into automatic operating mode and started 

 the blower is stopped 

 the MPC is put into manual operation with an internal manipulated variable 
of 0.0 % 

In the subsequent transitions, the respective feedback messages (e.g. motor 
stopped) are checked. 

The denitrification phase ends as soon as the nitrate concentration sinks below the 
threshold value of 0.8 mg/l and a minimum holding time of 3 minutes has elapsed. 

In the nitrification phase: 

 the agitator is stopped. 

 the blower goes into automatic mode with external manipulated variable value 
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 the MPC controller goes into automatic mode 

In the subsequent transitions, the respective feedback messages (e.g. Blower 
started) are checked. 

The nitrification phase ends as soon as the ammonium concentration sinks below 
the threshold value of 0.5 mg/l and a minimum holding time of 5 minutes has 
elapsed. 

Subsequently the process jumps back to the first stage of the denitrification phase 
and the step sequence is worked through from the beginning again. 

Structurally, this step sequence corresponds with the logic effectively used in the 
operation of sewage treatment plants with intermittent denitrification. The actual 
numerical values for the switchover thresholds may differ somewhat from the 
example values, depending on each system. The minimum holding times are 
adapted to the time-lapse. 

Step sequence “Sim_Feed_SFC” 

The step sequence “Sim_Feed_SFC” serves for the simulation of a disturbance in 
the form of a fluctuation of the inflow volume. The input to real sewage treatment 
plants is subject to fluctuations, both due to the weather (dry spells, sudden rain 
showers, etc.) and to variations of the water consumption of the connected 
households and industries in the catchment area of the sewage treatment plant’s 
sewage network.  

The step sequence sets the setpoint input of the analog control module “SimFeed” 
to external. Then the external setpoint input is set to 40 m

3
/h for 450 seconds. 

After 450 seconds the external setpoint is set to 70 m
3
/h for 150 seconds and then 

it is set to 50 m
3
/h for a duration of 600 seconds. At the end of the step sequence 

a setpoint of 30 m
3
/h is set for a duration of 960 seconds. After working through 

the last step the system jumps back to the first step once again. The sequence 
chain remains active until it is manually deactivated or the system itself is 
deactivated. When it ends, switching takes place again to the internal setpoint, 
which is set to the operating point of 40 m³/h. 
 

Note To determine the setpoint value and operating mode selection, the necessary 
parameterization is used, incl. the schematic representations from the function 
manual "SIMATIC Process Control System PCS 7 PCS 7 Advanced Process 
Library V8.1". You will find the function manual and further documentation under 
the following link: https://support.industry.siemens.com/cs/ww/en/view/59538371 

 

2.9 MPC Configuration 

2.9.1 Generation of Identification Data 

In order to generate identification data, the process is stimulated with manipulated 
variable steps and disturbance variable steps in manual mode of the MPC. 
The measured data are recorded with the CFC trend chart recorder or WinCC 
TagLogging and then exported. 

The stimulation of the manipulated variable and that of the disturbance variable 
take place in a separate manner (two trend curves) The stimulation of the 
manipulated variable in the present example is manual. Stimulation of the 
disturbance takes place via the SFC “Sim_Feed_SFC”.  

 

https://support.industry.siemens.com/cs/ww/en/view/59538371
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Figure 2-1 Recording of learning data with the CFC trend chart recorder 

 

2.9.2 MPC Parameter Assignment and Commissioning 

The parameters of the MPC are configured with the MPC Configurator, which is 
started from the CFC (mark MPC module, right-click/MPC configure...). This is 
done by loading the identification data, which has been previously recorded with 
the CFC trend display, to the MPC configurator. Two identification data sets can 
be loaded. 
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Figure 2-2: Learning data for MPC design: Stimulation of Disturbance variable 

 

 

The corresponding meanings are assigned to the measured variables 
(manipulated, controlled or disturbance variable). 

The time range shown above can be restricted in the "Step by Step" configuration. 
It is important to use an initial state which is nearly stationary (as good as possible) 
at the start of the time window for the identification. After all settings have been 
made, the process model is identified. 

The process model is displayed as a result. 
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Figure 2-3 Identified process model 

 

 

It is possible to show the step responses of the model and the approximated model 
equations. 

 

Figure 2-4 Approximate model equations  

 

 

An SCL source file is generated via the "Design controller" button. This is then 
inserted and compiled in the project. The generated data block is copied to the 
block folder of the S7 program and invoked by the MPC. 
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2.10 Process Key Performance Indicators (KPI) 

The "KPI" CFC chart comprises the key performance indicators that inform the 
operator about the process performance and energy requirement. The following 
key performance indicators are calculated and shown in the visualization: 

1. Sheet: Blower electrical power (current energy consumption) [kW]: 

𝑃ElecEnergy = 𝑃MaxPower × (
𝑆

𝑆MaxPower

)
3

 

with nominal output 𝑃MaxPower, revolution speed 𝑆 and nominal revolution 

speed 𝑆MaxPower. 

2. Sheet: Electric power consumption in kWh 

𝑊ElecEnergy =
1

3600
× ∫ 𝑃ElecEnergy 𝑑𝑡 

with the electric power of the blower 𝑃ElecEnergy. 

3. Sheet: Total nitrogen load in the TKN sequence in mg/l 
𝑇𝐾𝑁 = 𝑄𝐼𝑁𝐻4−𝑁 + 𝑄𝐼𝑁𝑂3−𝑁 

with the concentration of ammonium-nitrogen 𝑄𝐼𝑁𝐻4−𝑁 and nitrate-

nitrogen𝑄𝐼𝑁𝑂3−𝑁. 

The sum of “Organic compound” Nitrogen and Ammonium (NH4
+
) is called Total 

Kjeldahl Nitrogen (TKN). The measured values of QI_NH4 and QI_NO3 always 
provide the concentration of ammonium-nitrogen or nitrate-nitrogen in the water 
and are therefore referred to as NH4-N and NO3-N, respectively. 
 

Note To calculate the energy consumption, relevant technical data (rated power, etc.) 
has been pre-selected in the CFC chart "Characteristics_NC_O2". You can 
adapt this to your specific application. 

https://en.wikipedia.org/wiki/Chemical_compound
https://en.wikipedia.org/wiki/Nitrogen
https://en.wikipedia.org/wiki/Ammonium
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3 Integration of the Unit Template 

3.1 Preparation 

The following instructions describe the integration of the Unit Template in a PCS 7 
project where the following steps have been completed: 

 Adjusting HW Config 

 Configuration of the communication between AS and OS (NetPro) 

 Settings for the hierarchy folders 

 Usage of a uniform master data library 

Procedure 

1. Copy the file "109485916_ASUC_PROJECT_PCS7_V811.zip" to the 
configuration PC and then open the SIMATIC Manager. 

2. Click on "File > Retrieve" in the menu bar and select the file 
"109485916_ASUC_PROJECT_PCS7_V811.zip". Then confirm with "Open". 

3. Select the folder in which the project will be saved and confirm with the "OK" 
button. 
The project will be extracted. 

4. In the "Retrieve" dialog, click on the "OK" button and then click on "Yes" in the 
dialog to open the project. 

5. Switch to the "Technological view". 

6. Open in parallel the project in which the biological stage is to be integrated. 

3.2 Procedure 

The following instructions describe how to integrate the Unit Template in your 
project. It has been refrained from describing the interconnection of each individual 
signal and the setting of individual parameters. 

The open Unit Template and the opened target project in the technological view 
are a prerequisite. 

Procedure 

1. In the technological view of the biological stage, in the AS project select the 
hierarchy folder "BiologicalTreatment" and click on "Edit > Copy" in the menu 
bar. 

2. Change over to the target project. 
In the AS project, select the hierarchy folder under which the biological stage 
is to be inserted and then click on "Edit > Insert" in the menu bar. 
 

Note All plans, incl. the connections and simulation, are copied. 

 

3. In the target project, select the AS project and in the menu bar click on "Extra > 
Technological hierarchy > Synchronize in multiproject". 
The dialog box for exporting the technological hierarchy will open. 
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4. Confirm the dialog with "OK" and also confirm the next dialog by clicking "OK". 
The technological hierarchy will be adapted in the OS project of the target 
project. 

5. Compile and load the AS project and then compile the OS project. 
 

Note You can use the process picture of the biological stage of a wastewater 
treatment plant with intermittent operating mode from the example project. 
You will find these in the project path 
<Projektpfad>\WWTP\WWTP_OS\wincproj\OS(1)\GraCS\BiologicalTreatment.P
dl> 

 

In Chapter 6 of the application description "Equipment Modules for PCS 7 using 
the example of the Chemical Industry" under the following link: 
https://support.industry.siemens.com/cs/ww/en/view/53843373 where you will find 
detailed procedures, including notes on the following topics: 

 Integration of equipment modules 

– Adapting parameters of an equipment module 

– Interconnecting an equipment module 

– Integrating a color palette in the OS 

 Process interfacing 

 Configuration of the PID controller 

 

Note Observe the modified project path when integrating the color palette in the OS. 
The valid project path for the unit template "Biological Stage of a Wastewater 
Treatment Plant with intermittent operating mode" is 
<Projektpfad>\WWTP\WWTP_OS\wincproj\OS(1)\GraCS\UnitTemplates.xml>. 

 

https://support.industry.siemens.com/cs/ww/en/view/53843373
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4 Starting the Unit Template 

4.1 Preparation 

The following instructions describe the commissioning of the Unit Template by 
simulating the controller with the "S7-PLCSIM" program. If there is a real controller, 
you must configure existing hardware components in HW Config. 

Procedure 

1. Copy the file "109485916_ASUC_PROJECT_PCS7_V811.zip" into any folder 
on the configuration PC and then open the SIMATIC Manager. 

2. Click on "File > Retrieve" in the menu bar and select the file 
"109485916_ASUC_PROJECT_PCS7_V811.zip". Then confirm with "Open". 

3. Select the folder in which the project is to be saved and confirm by clicking on 
"OK". 
The project is retrieved. 

4. Confirm the "Retrieve" dialog with "OK" and then click on "Yes" in the dialog 
to open the project. 

5. Right-click on "WWTP_OS > PCS811ESOS1" and click on the "Object 
properties" menu item. 

6. Enter the name of your PC in the "Name" box of the “General” register. Accept 
the change by clicking on "OK". 

7. Right-click on "WWTP_OS > Name PC-Station > WinCC Appl. > OS(1)" and 
then click on the menu command "Open object". 

8. Confirm the "Configured server not available" dialog with "OK". 

9. In the WinCC Explorer, open the characteristics of your computer and, in the 
opened Properties dialog, click on the "Use local computer name" button. 
Confirm the "Change computer name" message with "OK". 

 

 

10. In the WinCC Explorer, click on "File > Exit" and in the subsequent dialog 
select "Terminate WinCC Explorer and close project". 
Then confirm with "OK". 

11. Reopen the WinCC Explorer as described in step 7. 

12. Double-click on “Tag management” to open it. 
Tag management opens in the WinCC Configuration Studio. 

13. Right-click on "Tag management > SIMATIC S7 Protocol Suite > TCP/IP" 
and select the menu command "System parameters". 
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14. In the "Unit" register, check the "Logical device names" setting. If the "S7 
PLCSIM" program is used, the device name "PLCSIM.TCPIP.1" is selected. 
If the device name has to be changed, the program must be restarted. 
Reopen the WinCC Explorer as described in step 7. 

 

4.2 Commissioning 

The following instructions describe how the Unit Template "Biological stage of 
a wastewater treatment plant with intermittent operating mode" is initialized. 

For commissioning, SIMATIC Manager must be already open and the project 
must be selected in the component view. 

Starting the simulation (S7 PLCSIM) 

To start the simulation, proceed according to the following instructions: 

1. Select "Extra > Simulate Modules" from the menu. The "S7 PLCSIM" dialog 
window opens. 

2. In the "Open project" dialog, select the "Open project from file" option. 

3. Select the file "BioTr.plc" from the project path 
"<Projektpfad\WWTP\WWTP_Prj>". 

4. In the menu, select "Execute > Key-switch position > Run P". 
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Activate OS (WinCC runtime) 

To activate the OS, proceed according to the following instructions: 

1. Right-click on "WWTP_OS > Name PC-Station > WinCC Appl. > OS(1)" and 
then click on the menu command "Open object". 

2. To activate the OS (WinCC Runtime), select "File > Activate" in the WinCC 
Explorer menu. 

3. Select the Unit template "BiologicalTreatment" in the image area (1). 

4. Click on the module icon of the “NitriDenitri” SFC (3). 
The SFC faceplate opens. 

5. Click the “Start” button of the SFC faceplate. 
The SFC starts. 

6. Click on the module icon of the “Plant_OnOff” digital control module (2). 
The faceplate of the “Plant_OnOff” module opens. 

7. Select the command “On” to start the display. 

8. Binary control “Start system” 

 

 

 

1 

2 

3 
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5 Principle of Operation 

5.1 Overview 

Some components of the biological stage can be controlled and monitored from 
the process picture. Furthermore, the process-specific key performance indicators 
can be changed in the lower-level "Simulation" picture. Based on their data, KPI 
calculations are then carried out. 

The following scenario relates to the handling of the "Biological Stage" Unit 
Template. It describes disturbance variable compensation when changing the feed 
volume of wastewater. 

5.2 Scenario – Disturbance Variable Compensation 

Description 

In this scenario, the controller reacts to fluctuations of wastewater feed flow. 

It is assumed that the wastewater feed flow changes. With regard to the curve 
representation, the feed volume fluctuates more frequently than in reality, i.e. on 
average by 20 m³/s every 9 minutes. 

The effect on the controlled variable is monitored in the curve recorder. 

Procedure 

1. In the OS, change to the lower-level "Simulation" picture. 

 

 

2. Click on the “Sim_Feed_SFC” block icon. 
The SFC chart faceplate opens. 
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3. Click the "Start" button and then on "OK". 
The step sequence is started. 

 

 

4. Switch to the "BiologicalTreatment" process picture. 

5. Click on the module icon of the “QIC_NH4”. 
The MPC faceplate opens. 

 

 

6. Click on the “Curves” button of the faceplate. 

 

The trend view is displayed. 
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Note In addition to the MPC target, actual and manipulated variables, the trend display 
also shows the disturbance variable. The modified trend display is saved in the 
project under the name “@PG_APL_TrendMPC_WUT.pdl” Variables and colors 
can be adapted at will. In order to show the standard MPC trend view, enter the 
value “@PG_APL_TrendMPC.pdl” in the property “Trend > TrendPictureName” 
of the module icon MPC. 

 

7. In the Trend view, click on the button for toggling between archive and online 
variables. 

 

 

8. Stop the curve recorder after approx. 35 minutes in order to carry out an 
evaluation of the recorded data. 

Note The individual controller values (SP, CV, MV and DV) are archived, so that 
you can select your own time ranges in the curve recorder. 
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Evaluation 

 

 

In the upper part of the curve recorder the nominal value SP1 (green) is constantly 
just below the switchover threshold, i.e. below the targeted ammonium 
concentration to be reached at the end of the nitrification phase. Through the 
setpoint pre-filter in MPC channel 1 with a time constant of 300 s (= 5 mins) 
a trajectory is defined internally that slowly leads the setpoint in the direction 
of the switch-over threshold. 

At a constant feed rate (DV1 black, time sector 1), during the nitrification phase 
(e.g. time sector 4) the blower revolution speed (MV1 orange) first rises steeply to 
around 40 %. Then the manipulated variable is only raised slowly and remains 
constant at the end of the nitrification phase. This way the MPC reaches the 
prescribed setpoint in the allocated time. During the denitrification phase (time 
sector 3) the blower speed is independent of the feed volume 0 %. After switching 
on the feed volume change, the wastewater feed volume is abruptly changed 
several times (time sector 2). If this change happens during the nitrification phase, 
the reaction of the MPC can be clearly seen (5 and 6). 

After the feed volume change is engaged, two jumps (5) fall in the primary 
nitrification phase. The nitrification phase begins with a feed volume of 40 m³/h. 
After a steep rise of the revolution speed to around 40 %, the revolution speed 
continues to rise, but only slowly. When the feed volume jumps from 40 m³/h to 
70 m³/h the MPC reacts increasing the blower speed to c. 98% in order to reach 
the setpoint in the allocated time. In the same nitrification phase the feed volume 
drops from 70 m³/h to 50 m³/h. The MPC adapts the blower speed and keeps it 
constant at around 87 %. The required setpoint value is reached in the allocated 
time.  

In the subsequent nitrification phase the feed volume is 50 m³/h to start (6). 
Compared with the preceding nitrification phase the blower speed rises steeply 
to 60 %. It then rises further to around 85 %. Here, too, a steeper rise takes place 
compared to a feed volume of 40 m³/h. After around 2/3 of the nitrification phase 
the feed volume drops to 30 m³/h. The MPC reduces the blower speed and the 
required setpoint value is reached in the allocated time. In the last nitrification 
phase of the evaluation presented here (7) the feed volume is at 30 m³/h. 
Compared with the nitrification phases with a feed volume of 40 m³/h, the increase 
in the blower revolution speed is significantly less steep. 

1 

4 

2 

3 5 7 6 
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